INTRODUCTION

The study of reaction kinetics is at the heart of chemical engineering. Together with separations (i.e., mass transfer) and process control, these three elements are chief distinguishing characteristics separating chemical engineering from, say, mechanical engineering. Similarly, knowledge and skill in these three disciplines distinguish chemical engineers from the rest of the engineering profession.

Laboratory and pilot scale experiments in kinetics – adequately performed – provide the necessary data and insights needed to understand reaction mechanisms; evaluate the effects of composition, temperature, and catalysts on the rates of reaction; and ultimately allow chemical engineers to design commercial scale reactors for the manufacture of valuable products.

BACKGROUND ON THE ETHYLENE HYDROGENATION REACTION

Researchers have long studied the hydrogenation of C\textsubscript{2}H\textsubscript{4} as a model reduction reaction in characterizing new metal catalysts. Beeck, in 1950, was one of the first to systematically study the reaction[1]. He found that nickel, while not the most active metal catalyst for this reaction, is active enough that the hydrogenation reaction can take place at < 200°C.

The reaction typically involves adsorbed, dissociated H\textsubscript{2} reacting with adsorbed C\textsubscript{2}H\textsubscript{4}. In other words, both hydrogen atoms and C\textsubscript{2}H\textsubscript{4} molecules form bonds with a metal site (here denoted as S). The strong bonding of C\textsubscript{2}H\textsubscript{4} with S weakens the double bond sufficiently to allow hydrogen atoms to add to C\textsubscript{2}H\textsubscript{4}, forming unadsorbed ethane. Butt has suggested a mechanism for the reaction (letting A = C\textsubscript{2}H\textsubscript{4}, E = C\textsubscript{2}H\textsubscript{6}, and S = a metal site) which one can write as follows[2]:

\begin{align*}
A + S &\rightleftharpoons AS \quad (1) \\
H2 + 2S &\rightleftharpoons HS + HS \quad (2) \\
AS + HS &\longrightarrow AHS + S \quad (3)
\end{align*}
\[ AHS + HS \rightarrow E + S + S \]  

(4)

If we assume the third reaction is the rate-limiting step, and that the total amount of S sites is constant \((S_0)\) we can derive an approximate mass balance:

\[ (S_0) \equiv (S) + (AS) + (HS) \]  

(5)

This mass balance, combined with the quasi-equilibrium assumption of the first two reaction steps, results in a reasonable but complicated theoretical kinetics expression:

\[ r = k(H_2)^{1/2}(A)(S_0)^2\left[1 + K_1(A) + K_2^{1/2}(H_2)^{1/2}\right]^{-2} \]  

(6)

Note that in the approximate mass balance we assume that

\[ (S), (HS) \text{ and } (AS) \gg (AHS) \]  

(7)

Also, note that \((S_0)\) is a constant as long as the total number of metal sites remains the same. When the number of metal sites decreases over time, we say the catalyst deactivates; when it increases, the catalyst activates. In this reaction, a side reaction can cause deactivation, described by the following stoichiometry:

\[ aC_2H_4 \rightarrow (CH)_{2a} + aH_2 \]  

(8)

The component \((CH)_{2a}\) – called coke – is too heavy (i.e., \(a\) is large) to desorb from the metal sites and so these metal sites are in effect removed from the catalysis[3]. However, subsequent reaction conditions may cause the coke to break down, in effect re-activating the catalyst.

For the kinetics described above, it is evident that the rate is first-order in \(C_2H_4\) for low concentrations of \(C_2H_4\) while it is -1 order for high concentrations of \(C_2H_4\). Rate expressions of this type – also common in enzyme-catalyzed reactions – are called Langmuir-Hinshelwood rate expressions. Since the equilibrium constant, \(K_1\), is temperature-dependent, this rate expression tells us that the order \(m\) for \(C_2H_4\) changes with temperature in a power law rate expression of the type:

\[ r = k(A)^m(H_2)^n \]  

(9)

Most rate expressions regressed from experimental data are of the power law type.

The catalyst used in the packed bed reactor employs Ni as the active component but contains \(SiO_2\) in significant quantity as well. The \(SiO_2\) serves as a support for the Ni; its only purpose is to provide a large surface area for the Ni to cover. The \(SiO_2\) is chemically inert under the conditions used here. Another inert material, \(SiC\), is used to fill up the rest of the reactor.

General reaction kinetics references abound. Fogler’s treatise is particularly well done[4].
Donated by the former Exxon Research and Development Laboratories here in Baton Rouge, the so-called CAT unit is capable of many different catalyst experimental testing strategies. Currently, it is equipped to facilitate heterogeneous packed bed reactor studies testing nickel and other metal-on-support hydrogenation catalysts in the hydrogenation of ethylene – C₂H₄. Figure 1 is a simplified schematic of the reactor system.

The reactor itself (detailed in Figure 2) is a steel tube contained within a sandbath. The sandbath is fluidized using air; metal resistance heaters provide heat. Large quantities of heat can be transferred rapidly to this pilot plant reactor. Catalyst cylinders are located in a narrow layer at a point roughly 4 inches above the lowest movable thermocouple position. Detection of the reaction exotherm (see Longitudinal Temperature Variation section later in this document) can be used to identify the precise location and extent of the catalyst bed.

Precautions have been taken to make this a safe system. The CAT unit comes equipped with relief valves, a high-temperature shutdown, and only a diluted H₂ feed stream (see the specification information on/next to the cylinder). However, with any reacting system, strict adherence to
safety procedures is necessary. The lower flammability limit of H₂ in air is 4 vol. %[5], therefore it is critical to ensure that the reactor is not leaking H₂ into the surrounding sandbath.

The Emerson Process Management DeltaV™ control system and connected instrumentation provide access to most measurement components of this pilot unit.

Figure 2 – Reactor mechanical drawing denoting thermowells and inlet preheat coil.
The following section is devoted to instructions on the typical operation of the pilot unit as currently configured.

LOGGING INTO AND USING THE DELTAV™ SYSTEM

Access to the DeltaV system is made possible in virtual fashion from a VLAB virtual machine reachable from any of the thin-clients in the control room proper. Though there are several DeltaV virtual machines available, the CHE–UOLAB–DV3 virtual machine is reserved and set up for access to the packed bed reactor unit. Accessing this virtual machine is done through Window’s Remote Desktop Connection feature, visible from the Start menu.

To access one of the DeltaV virtual machines after logging into a VLAB virtual machine, follow the steps outlined here:

- Click the Start button, then click the Remote Desktop Connection item on the popup menu.
- On the Remote Desktop Connection popup that appears, enter the name of the virtual DeltaV station desired. [For the Polymerization Reactor (POLY, use che-uolab-dv1 or che-uolab-dv4. For the Tray Distillation Unit (TDU), use che-uolab-dv2. For the Packed Bed Reactor (CAT), use che-uolab-dv3.]
- Click the Options button, and then click the Local Resources tab. Under Local devices and resources, click the More… button. Expand the Drives area if necessary. Check the apps drive box and the box for Removable Disk (if you have installed a jump drive and want it to be accessible from the DeltaV virtual machine). Click OK. Click Connect.
- At the Do you trust this remote connection? menu, click Connect.
- On the Windows Security popup that appears, click Use another account icon.
- In the two fields that appear next, type \admin\istrator in the Use name field and deltav in the Password field. Click OK.
- A Remote Desktop Connection warning menu appears next. Click Yes.
- A DeltaV Logon menu appears next. Type deltav in the Password: field. Click OK.
- A Flexlock menu window appears next. Click the Windows Desktop button. Minimize this menu window.

At this point, the DeltaV virtualized station of choice is up and operating, allowing access to the DeltaV Operate Run program and the Process History View program (and Control Studio from che-uolab-dv1) from the Windows Start menu. Windows Explorer on the DeltaC virtual machine should allow access the apps drive and a connected jump drive (if installed).

To start up the control schematic navigate to Start > DeltaV > Operator > DeltaV Operate Run. The UOLAB_Overview display should come up. Click on the hot-linked photo.
of the Exxon Catalytic Reactor unit. Doing this should automatically open the CAT1 display. If a dialog box appears indicating an error, click [Skip All] on the dialog box.

### CHANGING CONTROLLER PARAMETERS FROM CONTROLLER FACEPLATES

On the operations schematic, the appearance of a small icon – identifiable by a gray box with three vertical lines – signals the presence of an automatic controller. To the left of each controller icon are the process value (PV, the measurement) in yellow, the setpoint (SP) in white, and the output (OP) in cyan. To change a parameter on a controller, click on this icon to bring up a faceplate. From the faceplate, an operator can change the controller mode by clicking on the desired mode button on the left side of the faceplate.

Manually changing the controller output (OP) is only possible in MANual mode. To change the controller output, click on the MANual value field at the top of the faceplate and enter a new value. Click-dragging the large cyan pointer to a new position also changes the output of the controller, though that pointer is present only in MANual mode. The smaller cyan pointers are output limit indicators. The controller faceplate does not allow changing these.

When the mode is not MAN, the controller uses the process value (PV), setpoint (SP) and tuning constants to calculate a new output (OP) every processing pass.

Manually changing the controller setpoint (SP) is only possible in AUTO mode. To change the controller setpoint, click on the setpoint value field on the right side of the faceplate and enter a new value. Click-dragging the large white pointer – present ONLY when the controller is in AUTO – to a new position also changes the setpoint of the controller. The smaller white pointers setpoint limit indicators. The controller faceplate does not allow changing these.

### ACCESSING ADDITIONAL CONTROLLER DETAILS

Across the bottom of the faceplate are six icons that call up other displays with more details about this controller. The two most useful ones for this experiment are the first one from the left, which provides access to controller parameters; and the second one from the right, which calls up the historical trend for this controller.

### ACCESSING REAL-TIME PROCESS HISTORY

To start up the real-time process history view at any time, navigate to Start > DeltaV > Operator > Process History View, and then open CATUnitOverview (if it does not open automatically). Chart scales can be compressed or expanded by clicking those buttons on the menu bar. Scales can be shifted up or down by click-dragging on the scale of interest.

### STARTUP

1. Make sure that the air to the sandbath is on. The rotameter should read 7.0 and be held constant from run to run to provide consistent heating.
2. Enable power to the sandbath heater by pushing the black-colored START button on the CAT unit’s panel board.

3. Set automatic temperature controller (TIC-10, for the sandbath) to desired initial set point, if a reactor temperature above ambient is required.

Set mode to AUTO unless intended operations require a specific controller output.

[You can also turn the auxiliary heater on (output ≤ 90%) if you desire a rapid heat up. Be sure to it turn off when the skin (heater) temperature nears your desired reactor temperature; the control of the auxiliary heater is not possible at this time, and cooling (≈10°C/hr) takes much longer than heating.] – Not typically recommended – See Instructor for guidance.

The reactor temperature can lag the heater temperature significantly. It is best to change the selector switch for TIC-10 to the skin thermocouple, enabling the controller to use the skin T/C as its input. Raise the intended setpoint a small amount to compensate for the difference in temperature between the skin and reactor temperature (anywhere from 2 to 5°C is typical, depending on the desired reactor temperature).

The highest temperature to be used in any experiment is 200°C. The DeltaV™ computer has been programmed to reduce the input heating power by half at 200°C and to shut off the heaters at 220°C. A "CRITICAL" warning light alerts you to the high temperature. The DeltaV monitors both the sandbath and reactor temperatures and both are programmed to alarm and shut off the heaters.

4. Be sure the breaker for the sandbath main heater (#10) is on, as well as breakers for instrument power (#4), tape heater and GC (#5), and control (#7).

5. If the ammeter for the sandbath heaters is not showing current, press the START switch.

**Special Item:**

It is possible to perform steps 1 through 5 rapidly the morning of the experiment, then leave the experiment unattended with NO GAS FLOWS. The catalyst is stable in a no flow condition and, most typically, one can start the flows at the start of the afternoon lab period.

If so elected, complete and post the Unattended Operations Placard provided in the Appendix of this manual, following the instructions therein.

The operator can monitor temperatures on the chart contained on the control schematic or – even better – using Process History View. The operator should check the reactor effluent flow rate periodically. If problems (loss of flow, runaway temperature) develop, SHUT OFF BOTH REACTANT FLOWS USING APPROPRIATE SHUTOFF VALVES AND TURN ALL HEATERS OFF. LEAVE SANDBATH AIR ON.

The reactor temperature may show some oscillation around the controller set point. Such oscillation is normal. However, it is not normal for the sandbath temperatures to exceed the reactor temperature by more than 10 °C after a prolonged period. This condition may indicate a
blocked filter on top of the sandbath or otherwise poor fluidization. Remove and clean it, even if the unit is running.

*Should the experimental program suggest or call for the use of greater-than-atmospheric pressure reacting conditions, this can be accomplished by loading the dome of the reactor back pressure regulator (V-8) with nitrogen pressure. Ask a suitable instructor, the Lab Coordinator, or the Lab Manager for guidance on how to do this. Unless otherwise advised, limit reactor pressures to 30 psig. (Note: Tests in the fall of 2009 indicated that the flow meters yield the same flow calibration above 0 psig as they do at 0 psig.)*

### SETTING FLOW RATES

Set flow rates before turning on heaters on Day 1. The H₂/N₂ mixture is set first, using mass flow controller FIC-301. FIC-301 should exhibit a linear but uncalibrated response. To minimize uncertainty in reaction rate and other calculations based on this flow rate, a precise calibration of this meter is needed, relating %PV (i.e., percent process variable) to the actual flow, corrected to standard conditions, as measured by the soap bubble-o-meter.

To build this calibration, bypass the reactor, place the FIC-301 H₂/N₂ flow controller in AUTO (automatic) mode and measure the exit flow rate over a range of PV values by changing the controller’s setpoint. After changing the setpoint, wait until the PV reading is steady at the desired value before conducting the bubble-o-meter and stopwatch measurements. Use the results from this work as a stand-alone calibration for FIC-301. If the calculated zero (0% of input) is far from zero flow or the calibrated span (100% of input) is far from the estimated maximum flow rate of this meter, there may be a problem with the instrument requiring the attention of the Lab Coordinator. When finished checking this flow meter calibration, re-route flow through the reactor. Recheck the flow rate at one of the high setpoints used previously. It should be close to the reading observed when bypassing the reactor. If this reading is well below (say > 10%), there may be a significant leak in the reactor; notify the Lab Coordinator.

Calibrate the ethylene mass flow controller, FIC-302, in a similar fashion.

To start a reaction, route (or re-route) the combined H₂/N₂ mixture and C₂H₄ flow to the reactor.

If the chromatographic method in use is capable of complete (i.e., all components) feed analysis, it is probably wise to take at least one sample with the feed through the bypass (a blank sample) to determine the feed composition. It is permissible to change flow rates on the fly without bypassing the reactor. Again, if GC method allows for it, one can verify that the gas chromatograph is set-up correctly by running the H₂/N₂ and C₂H₄ separately, and checking the results versus the composition noted on the cylinder labels. (As of 020218, this is not possible.)

### Special Item:

N.B.: When either calibrating meters or checking exit flow rate during reaction – indeed, anytime the bubble-o-meter is being actively used to measure flow – the Agilent GC sample line should be blocked out. If not, gases from the GC contribute erroneously to the measured flow rate through the bubble-o-meter.
LONGITUDINAL TEMPERATURE VARIATION

As the conversion of ethylene increases, even the small quantity of catalyst and the significant amount of carborundum diluent present in the reactor may not prevent a longitudinal increase in temperature from occurring, resulting in a non-isothermal kinetic impact on reaction rate. If this is of consequence to the experimental program, the longitudinal temperature variation can be measured, and its effect accounted for in the post-run analysis.

The following steps illustrate how to measure longitudinal temperature variation while carrying out the ethylene conversion reaction:

1. With the reactor thermocouple (TI-71) bottomed-out to its full extent in the reactor centerline thermowell, collect sufficient data (using the method outlined later in this manual) to identify an average temperature from this thermocouple.

   Note: When using either a sandbath or skin couple for temperature control, moving the reactor couple will not disturb control. If, however, the reactor thermocouple is being used to control temperature, then moving the reactor couple will affect temperature control undesirably. To avoid this, temporarily place the temperature controller in MANual mode while performing this procedure, returning it to AUTO mode after completion of the procedure.

2. Lifting this thermocouple a small and known distance up (1 cm or ½ inch, at most), again collect sufficient data to identify an average temperature from this thermocouple. This thermocouple may be very hot. Use appropriate gloves or a cloth to protect fingers from the lower portion of the couple (see the Lab Coordinator for any needed materials).

3. Repeat step 2 until the thermocouple no longer shows a rise in reactor temperature. A chart of these average values will reveal the start and end of the catalyst bed temperature rise, as well as the quantitative data necessary to deal with longitudinal temperature variation resulting from this exothermic reaction.

4. After gathering all necessary data, return the reactor thermocouple to its bottomed-out position, being careful to guide the couple down without crimping it. This thermocouple may be very hot. Use appropriate gloves or a cloth to protect fingers from the lower portion of the couple (see the Lab Coordinator for any needed materials).

CHROMATOGRAPH OPERATING INSTRUCTIONS (AGILENT 3000A MICRO GC)

USING THE AGILENT 3000A

Use of the Agilent 3000A Micro GC requires the following: a) the GC is powered up and on, b) carrier gases are available and aligned, c) the gas source to be analyzed is aligned, and d) software to operate the GC and analyze results is accessible. Follow the instructions given below.
1. Check to make sure the carrier gases (i.e., helium and argon cylinders to the rear of the GC itself) are open to the GC, and that pressure levels meet manufacturer’s recommended value (i.e., supply pressures of 80 ± 2 psig and cylinder pressures of 200+ psig). If the levels look high or low, contact the Lab Coordinator; do not adjust regulators.

2. Check to ensure the direct connect tubing line to the GC is connected to the source to be analyzed; i.e., the standard gas cylinder if calibrating or the CAT unit itself if analyzing process gas. (Calibration gas bomb pressure should not be more than 25 psig; more typically it should be 5-to-10 psig.) Contact the Lab Coordinator for assistance in moving this tubing line from one source to another.

3. Log in to a different thin-client (different from the one through which you are running the CAT unit) in the UO Lab Control Room computer using your LSU ID and password.

4. Double-click on the GC3 icon to open the Agilent Micro GC virtual machine.

5. On the desktop of that virtual computer, click on the icon for MicroGC 3000 (online), as shown in Figure 3 below, to open the GC operating and analysis software:

![Figure 3 – Desktop view of the GC3 virtual machine.](image)

6. At this point, a navigation window appears, as well as a top menu with icon buttons and a grey screen.

7. If the previous user of this GC has appropriately completed shutdown procedures, the GC method in place should be the one named “cooling-1.” This method turns off the detectors and lowers temperatures within the GC when not needed for sample analysis.
8. To operate the GC during experimentation or calibration, load method “PH-CAT4”. To do so, click **File → Open → Method** and choose the method titled “PH-CAT4” from the list of menus shown. Click **Control → Download Method** to load this method into the GC’s current method. The method then downloads into the GC’s instructions for intended use. The method name should display at the very top of the window.

9. Display the Instrument Status by clicking on **Control → Instrument Status**. It may take some minutes for the GC method settings to equilibrate. One cannot perform a run until all parameters in Instrument Status are green and the Instrument Status is Ready.

![Figure 4 – Instrument status screen with all parameters green and instrument is Ready mode.](image)

10. To perform an analysis, proceed as follows:
    a. When ready to perform a run, click on **Control → Single Run** (same top line as File). A popup menu appears, as in Figure 5, allowing sample description.

![Figure 5 – Run description menu.](image)
b. Each run will need both a Sample ID, Data File and Result Name for the GC to store results properly for later access. The following choices for those items make good sense:

   i. **Sample ID** – Best here would be team identification, perhaps something like MW06 or TT10, to make finding results easy by clicking **File → Open → Results Set** later to look for these.

   ii. **Data File** – Click the arrowhead to the right of this field and select Date and Time. After doing so, `<D>` appears in the field. The `<D>` will attach the data and time to individual samples to identify precisely when the GC ran a particular sample.

   iii. **Results Name** – Click the arrowhead to the right of this field and select Sample ID, then repeat selecting Date and Time, then repeat selecting Increment Number. Return to the field and insert a single blank space between the first and second item and also between the second and third item. Later, when looking for the data, the Results Set will have a name that includes all three of these elements. Great for identification purposes.

   iv. **Number of reps** – Complete this field with the number of sequentially repeated analyses desired. There are unique concerns here: one cannot view detailed results until completion of ALL the reps. Therefore, exercise great caution when entering a large number into this field UNLESS sure that that number of runs is needed and there is no problem waiting for **ALL** to complete to see **ANY** detailed results.

   v. Once these lines complete, click **Start** in the popup window. Two plots will pop up, one each for the A and B detectors.

c. It may take a minute or two for the software to begin plotting. Changing of the status bar (bottom right-hand corner) from green to purple to blue indicates successful run setup. If a popup appears, asking if it is OK to start data acquisition, answer it affirmatively.

![Figure 6 – Result Review Mode screens.](image)

11. Depending on the compounds tested for, results will come from Channel A and Channel B. Live plots for both of these channels will appear, showing the real-time generation of chromatograms. Hydrogen and nitrogen will be detected on channel A, while hydrogen, methane, ethylene, and ethane appear on channel B. However, the method – **as of 020218** – has only been certified/vetted/calibrated for the ethylene and ethane results. (See later discussion on how to use these results to estimate fractional ethylene conversion).
12. When all reps are complete, a message appears suggesting that “The current method has changed – Would you like to save it?” **ALWAYS** select **NO** to this prompt. At this point, the Result Sequence window opens, allowing access to needed results.

13. To view the results for a run immediately after all reps are complete, select the Result Sequence window, click – for example – the first run number cell (contains a 1), right-click that cell and choose Select Record. Go to the top menu and select **Reports → View → Area %**. A report with the known compounds will pop up.

14. To calculate conversion from any rep’s result use the following formulae/values

\[
\text{Conversion fraction} = \frac{\text{Ethane Area}_\text{SAMPLE}}{\text{Ethylene Area}_\text{SAMPLE} + \text{Ethane Area}_\text{SAMPLE}} \cdot \text{[Response Coefficient]}.
\]

where

\[
\text{Response Coefficient} = \frac{\text{Ethylene Area}_\text{STANDARD}}{\text{Ethane Area}_\text{STANDARD}} = \frac{\text{Ethylene %}_\text{STANDARD}}{\text{Ethane %}_\text{STANDARD}}.
\]

where currently

\[
\text{Ethylene %}_\text{STANDARD} = 14.99\% \\
\text{Ethane %}_\text{STANDARD} = 14.98\%
\]

If no calibration data is generated, use \(1.000 \pm 0.009\) for Response Coefficient.

15. When finished with the GC for the day, download the “cooling-1” method and make sure that the GC does, in fact, change conditions to the cooling conditions.
16. Log out of the GC3 virtual machine going through the Start button on that virtual machine. DO NOT merely X out the application (do NOT exit via the X at the top of the VM session bar). Logging off not using the Start button would leave this user logged into GC3, preventing the other users and instructors from logging in.

17. Leave the carrier gases on.
18. When finished using both the GC and DeltaV, log off both thin-client machines.

**REACTOR SHUTDOWN**

The following steps constitute a safe and orderly shutdown of the Exxon Catalytic Reactor Unit:

<table>
<thead>
<tr>
<th>Procedural Step</th>
<th>Rationale or Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Shutdown main power to the sandbath heater by pushing the red EMERG. STOP button on the CAT unit’s panel board. Carefully push the TIC-71 couple all the way down into the thermowell.</td>
<td>After observing the upper ammeter for 20-30 seconds, there should be no movement and a 0 reading on this meter. Pushing the T/C all the way down ensures that the next user of the unit can trust its position.</td>
</tr>
<tr>
<td>2. Place TIC-10 in MAN mode and set the output to 0%.</td>
<td>Placing this setting on the heater controller will prevent the heater from restarting or firing immediately after pushing the START button in the future.</td>
</tr>
<tr>
<td>3. Set auxiliary heater output to 0%, if on.</td>
<td>We (almost) never use this heater.</td>
</tr>
<tr>
<td>4. Set C₂H₄ flow to 0% by putting the controller in MAN and setting the output to 0%. Shut off both C₂H₄ block valves before the mixing tee and shut off the main gas cylinder valve.</td>
<td>These procedures guarantee that ethylene will not enter the unit until critical valves are open. Additionally, the mass flow controller valve assembly will suffer overheating damage if not shutdown properly.</td>
</tr>
<tr>
<td>5. Leave air flow to fluidized bed at a rotameter setting of 7.</td>
<td>If the CAT unit does not run again until the next experimental cycle, air can be cut out by closing the needle valve and the block valve on the air supply line.</td>
</tr>
<tr>
<td>6. Wait ~ 2 minutes; then shut off H₂/N₂ mixture flow to the reactor – and the N₂ flow to the reactor, if on – by placing these controllers in MAN and setting the outputs to 0%. Block both valves before the mixing tee. Shut off H₂/N₂ mixture and N₂ main cylinder valves.</td>
<td>Maintaining H₂/N₂ flow for those 2 minutes leaves a blanket of this mixture in the reactor, prolonging the life of the catalyst. Additionally, the mass flow controller valve assemblies will suffer overheating damage if not shutdown properly.</td>
</tr>
<tr>
<td>7. Relieve pressure on the reactor back pressure regulator IF its setting is above 0 psig.</td>
<td>Doing so will ensure that the reactor does not sit idle in a pressured up condition.</td>
</tr>
<tr>
<td>8. Direct exit gas piping and valves from the unit are to the atmospheric vent line and close the block valve from that vent line to the bubble meter. All other valves should be left open.</td>
<td>The main risk to safety on this unit is letting gases exit the unit by any other means than the atmospheric vent. Making sure these valves are in the correct position will mitigate against this possibility.</td>
</tr>
</tbody>
</table>
EMERGENCY HEATER SHUTDOWN

If the reactor heater needs to be shut down under emergency conditions, press the red Emergency Stop (EMERG. STOP) button on the front panel of the unit IF CONDITIONS PERMIT THIS TO BE DONE SAFELY.

HISTORICAL DATA ACCESS USING DELTAV CONTINUOUS HISTORIAN

The DeltaV keeps a continuous historical record of all relevant temperatures, flows, and levels. One can import selected portions of these data into an Excel™ spreadsheet for analysis. Save this spreadsheet to a flash drive, personal directory, or the apps drive for future use. Do not trust the DeltaV virtual machine storage for such files.

To import data from DeltaV history to Excel™, Emerson has provided an Excel™ add-in called the DeltaV Continuous Historian. It appears under the Add-Ins menu in Excel™ when opened on a DeltaV workstation. One can import any process variable enabled in History Collection. Most of these variables are collected every 10 seconds, 30 seconds, or 1 minute, so it does not make sense to try to read the data any faster.

Though the menu features of the DeltaV Continuous Historian can be used for their intended purpose, requesting an ad hoc retrieval of data for more than one or two tags is tedious and time-consuming. Avoid such tedium by using the Excel™ template file available for CAT data retrieval. This template is preloaded to request ALL the historically trended CAT tags. The only information that the user must supply is the starting date and time, the ending date and time, and the time interval between data values.

To import data, open Excel™ on the DeltaV workstation and follow these steps:

1. Put Excel™ calculations in Manual mode before opening the template or attempting to change the starting and ending dates. Manual mode may already be active but check.

2. Open the data retrieval template file for CAT.

   It is located on the Desktop, in the DeltaV_Excel_Data_Collector_Files folder under the name CAT_Data_Retrieval.xlsx

3. Enter (or modify) the starting date and time for the data of interest as mm/dd/yyyy hh:mm into cell A4.

   For example, for data starting January 29th, 2018 at 9 AM, enter 1/29/2018 9:00

4. Enter (or modify) the ending date and time for the data of interest as mm/dd/yyyy hh:mm into cell A6.
For example, data ending January 29th, 2018 at 3PM would be entered as **1/29/2018 3:00PM** or **1/29/2018 15:00**

5. Enter (or modify) the desired time interval between data values.

For example, to request data values every 10 seconds, enter **="10seconds"** into cell A8. For data values every 2 minutes, enter **="2minutes"** into cell A8. Any value of seconds, minutes, or hours is OK, but some values make more sense than others. Using values faster than the fastest data collected originally makes no sense. So, requesting values below 10 seconds only make sense if when original data collection intervals were below 10 seconds. Interpolated values appear where there are no data values.

A maximum of 2161 readings (2160 intervals) is possible in any one data retrieval operation, allowing the retrieval of 6 hours of 10-second data, 36 hours of 1-minute data, or any other combination that results in 2160 (or fewer) intervals. If more data are required, two separate requests must be made and concatenated manually. Of course, if only a few tags are needed, one can bypass the use of the template and retrieve data ad-hoc using DeltaV features.

6. After entering the last of these user inputs, click the Add-Ins menu tab, click the DeltaV drop-down tab, roll over the Continuous Historian option, and select Refresh. All values in the spreadsheet should update, signaling successful retrieval of data.

7. To save results, turn the data into static values, as follows:

Select the entire worksheet (by clicking in the upper left-hand corner of the worksheet adjacent to the A1 cell. Copy this selection (e.g., ctrl-c). Select the 2nd worksheet tab. Using Paste Values, paste the values copied from the Data Collection tab into the 2nd worksheet. These values are now static and will be available even when opening the spreadsheet on another computer. Now, the first tab is superfluous, allowing its deletion, unless it is necessary to retrieve additional data from the DeltaV using this same file.

8. Save this file under a different name onto the desktop of the DeltaV virtual machine. To get this file to the apps drive, for example, right-click the file and click **Copy**. Then, minimize the Remote Desktop Connection machine, access the desired destination from the original client desktop and **Save** to the appropriate folder/location. (Remember that calculation mode for that file is **Manual**.)
REFERENCES


APPENDIX

Unattended Operations Placard (See next page.)
Exxon Catalytic Reactor Unattended Operations

Unattended Use\(^1\) by: ______________ between ______ and______ on _________

Nitrogen Flow Rate (cc/min): ____________________________

Heating to Reactor Temperature, °C __________ Pressure, psig ______________

☐ Email Notification to Lab Manager (markrlee@lsu.edu) at: ________ (clock time)

<table>
<thead>
<tr>
<th>If necessary, hydrogen/nitrogen flow can be stopped immediately by blocking out the supply cylinder behind the unit. It is the far right cylinder as you face the back of the unit. Turn the main cylinder valve clockwise until closed.</th>
<th>If necessary, ethylene flow can be stopped immediately by blocking out the supply cylinder at floor level on the unit skid’s left side. It is the only cylinder at that location. Turn the main cylinder valve clockwise until closed.</th>
</tr>
</thead>
</table>

---

1 Hang this form on the reactor sandbath after completing accurately with needed information. Make sure that the exit gas valve is directed to vent and **NOT** the bubble meter.

2 Here, post the times between which the unit will be unattended by you, and the date.